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1. GoldenEye™ Hyperspectral Imager Setup Guide 

1.1 Introduction 

The GoldenEye™ snapshot hyperspectral imager is a high-performance, ultra-miniaturized hyperspectral 

imager based on BaySpec’s FT-PI proprietary technology. This novel imager features high sensitivity, full 

VIS-NIR wavelength coverage and one-shot operation. Compactness, simple operation, and intuitive 

software make the GoldenEye™ Hyperspectral imagers very straight forward for applications ranging 

from remote sensing to biomedical fluorescence imaging.  

 

Key Features of GoldenEye™ 

• Full VIS-NIR 400-1100 nm coverage 

• Extremely compact and lightweight 

• Snapshot imager with one-shot operation 

• Real-time image preview 

• High sensitivity for low light applications 

• Innovative design significantly reduces system 

complexity and enhances reliability  

 

 

 

  

 

 

 

 

 

 

 GoldenEyeTM hyperspectral imager delivery package:  

(1). GoldenEye imager with pig-tail cables 

(2). Standard lens (8mm) 

(3). USB 3.0 hub (example shown in the picture) 

(4). External Trigger connector (with 1-ft long open-

end cable, not shown in the picture) 

(5). Software and User Manual in Flash Drive (not 

shown in the picture) 

 

 

 

 

 

 

 

GoldenEyeTM hyperspectral imager with a 

standard f=8 mm (40° FOV) lens, in an ultra-

compact package. 
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1.2 Hardware Set Up 

The setup process for the GoldenEye Hyperspectral Imager is remarkably straightforward. The imager 

comes with two USB cables: a blue-inserted USB 3.0 and a black-inserted USB 2.0. These cables power 

and control the imager. For PCs with multiple USB ports (including one USB 3.0), direct connection 

suffices. Alternatively, if only one USB 3.0 port is available, the provided USB 3.0 Hub bridges the 

connection, as demonstrated in the setup example below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

The imager supports external triggering. You may connect the imager to your trigger signal source via the 

provided connector and cable. See Section 1.3 for the details of the requirements of the external triggering 

signals. 

The GoldenEye Hyperspectral imager is usually shipped with a C-mount lens. The standard lens included 

is a compact, near-infrared (NIR) enhanced lens with 8 mm focal length, covering 40° FOV. Additional 

C-mount lenses with different FOVs (field of view) can be ordered from BaySpec.  

Note: You may change the lens aperture f number based on environment light conditions. The 

recommended lens aperture is no bigger than f/2.0 (i.e., f/16 to f/2.0 are allowed, but not f/2.0 to f/1.4). 

The best results are with apertures smaller than f/2.8, and the smaller the better. 

Note: The recommend computer configuration is listed below: 

 OS:   Windows 10/11, 64-bit 

 CPU:   Intel® Core™ i5 or higher   

 RAM:   16 GB or higher (32GB for using high resolution option) 

 Storage:  500 GB or higher 

 USB Port:   one or more USB 3.0 SuperSpeed 

 Display:  1200 × 800 pixels or higher    

 

An example setup of the GoldenEyeTM Hyperspectral imager. 

USB 3.0 Hub 

Computer 
Windows 10 64-bit with  

at least one USB 3.0 ports 

GoldenEye 

USB 3.0 
Port External Triggering signal  

(See Section 1.3 for specifications) 
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1.3 External Trigger Specifications 

GoldenEye imager takes a rising edge trigger-in signal and outputs trigger-out signals when doing data 

acquisition. The schematics of the connectors and the signal specifications are listed below: 

 

 

  
GND (black wire) 

Trigger-out (white wire) 

Trigger-in (red wire) 

External Trigger Signal Specifications: 

② - Trigger-out:  
 Type: Open collector NPN,  

 Maximum output dropout: 1.8V (sink current 25mA)  

 Maximum sink current: 25mA 

 Maximum Open circuit Voltage: 24V 

③ - Trigger-in:  
 2.0V ~ 11.0V pulse, rising edge triggering 

1kΩ 

VCC 

① 

② 
Trigger-out (white) 

GND (black) 

Trigger-out signal wiring 

Trigger-in 

Trigger-out 

DAQ 

Trigger Signal Timing Diagram 
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1.4 Software Set Up 

1. Copy GoldenEye vx.x.x folder from the Flash Drive (coming with the imager) to your computer 

and create a shortcut to GoldenEye vx.x.x.exe on the desktop. 

2. Copy USB Driver folder in the Flash Drive (included with the imager) to your computer, open it 

in the file explorer and double click Install_Driver_x64.bat to install the USB driver. 

1.5 Set up GoldenEye Imager for Measurement 

Below are general steps to follow for using the imager: 

1. Secure the imager on tripod (Note: the imager and the scene/target cannot be in motion during 

image acquisition). 

2. Screw the C-mount lens into the imager, if not already, and remove the lens cover. 

3. Power on the desktop/laptop/tablet PC with Windows 10 OS. 

4. Attach the USB 3.0 cable (connector with blue insert) from the imager to Port 4 of the USB 3.0 

hub (furthest from hub cable). 

5. Attach the USB 2.0 cable (connector with black insert) from the imager to Port 1 of the USB 3.0 

hub. 

6. Attach the hub cable to the computer and start the program GoldenEye.exe. 

7. Although the imager can be used immediately, for the best results, allow imager’s temperature 

(shown on the software interface) to stabilize. The imager’s temperature will reach approximate 

35 to 40 degrees Celsius at ambient temperatures. 

8. Set lens aperture to no larger than f/2.0 (i.e., f/16 to f/2.0 are allowed, but not f/2.0 to f/1.4; the 

best results are with apertures smaller than f/2.8, the smaller the better). 

9. Point the imager lens to the scene/target under a certain light source (see Note below) and adjust 

lens focus. 

10. Vary lens aperture, as well as gain and exposure time in the software, to ensure that no portion of 

the image on the display is saturated (saturated regions will appear darker or black in the final 

hyperspectral image, so if regions of the final hyperspectral image appear “burnt” this is likely 

what is happening, and exposure, gain, or aperture size need to be decreased. Note that with typical 

lighting conditions, better results could be obtained with a shorter exposure time (e.g. 10ms) 

and a higher gain (e.g. 3.0dB). Please experiment and determine as desired. 

11. If at any time the camera appears unresponsive, quit the program, unplug and re-plug the USB 

cables, and restart the program. Note that sometimes changing tabs in the software requires more 

than one press on the tab you are changing to. 

Note: The Light source can be sunlight or a halogen lamp (~ 50 W) whose spectrum is generally 

flat (uniform) at the wavelength range of 400-1100 nm. The commercial CFL or LED lamps are not 

recommended because their spectra are not uniform. Illumination should be relatively even on the target. 

Avoid creating shadows on the target while acquiring images.  
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Note: By default, the imager is configured to capture data across the extensive spectral span of 

400 - 1100nm, generating 141 hyperspectral band images with approximately 5nm intervals. For greater 

customization, users have the freedom to establish their own wavelength bands using integer steps. For 

instance, if specific wavelengths are preferred, or, finer band increments are desired in shorter wavelengths 

while coarser steps suit longer wavelengths for enhanced resolution alignment, users can achieve this by 

compiling a list of the desired wavelengths (within the 400nm to 1100nm range, in monotonically 

ascending order, with a minimum step of 1nm) within a "wavelengths.csv" file. This file, adhering to 

the "CSV (Comma delimited) (.csv)" format, should be placed in the application's root directory where 

"GoldenEye.exe" resides. The software will parse this file to generate hyperspectral band images 

according to the specified wavelength parameters. Below is an example of "wavelengths.csv" which sets 

up only reporting the wavelength bands in the list (from 580nm to 950nm, at an interval of 5nm). 

 

 . . . . . 
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2. GoldenEye™ App User Guide 
 

Note: If a BaySpec computer is provided, the software and drivers have already been installed and 

configured properly for the imager. If you are using your own computer, please follow the instruction in 

Section 1.3 to install the software and device drivers. 

 

BaySpec’s GoldenEye™ App is built for running under Microsoft Windows10 64-bit OS. The application 

is designed for non-experienced users to easily operate the imager to acquire images and construct 

Hyperspectral cubes (a series of images of wavelength bands). This single user interface (UI) design makes 

the App simple, focusing, and easy to use. 

2.1 UI Overview  
 

 
 

The App’s user interface consists of three portions: 

1. Operational Tabs: for user to choose what operation to perform. There are four tabs, namely 

Acquire, View, Analyze, and Save. A typical measurement procedure will follow the sequence of 

the tabs: Acquire → View → Analyze → Save. However, you can jump to any tab at any time. 

2. Image Display Panel: depending on the choice of the operational tabs, this panel displays preview 

images (Acquire tab), acquired raw images (View tab), and processed band images (Analyze tab). 

For Save tab, it shows the GUI for operations of saving and loading image files.   

1 

2 3 
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3. Control and Information Panel: depending on the choice of the operational tabs, this panel 

contains operational buttons and controls. It also displays information regarding device status, 

measurement data and graphs, saved spectral files, and a simple instruction of using the buttons 

and controls.  
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2.2 Acquire tab 

The UI associated with Acquire tab is the starting point of every measurement. When the App is up and 

running, the Acquire tab is selected by default. The real-time preview images will be displayed on the 

Image Display Panel immediately.  

 
 

 

4 

5 

8 

6 

2 

1 

3 

7 

9 
8 

10 

10 

9 
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There are a few of components on the Control and Information Panel. Here are their description and 

function: 

1. Sampler Box: for measuring the average intensity inside the enclosed area on preview image. 

Within the preview window, the sampler box can be moved by either single-clicking left or right 

mouse button, or dragging with holding the right mouse button down, to anywhere on the preview 

image (will center the sampler box at the point where mouse button is released). The sampler box 

can also be resized by either rolling the mouse scroll wheel (will keep the center of the sampler 

box unchanged) or dragging with holding the left mouse button down (will create a new sampler 

box with a size drawn by dragging). 

2. Temperature Information: shows the current internal temperature of the imager, e.g. “34.5 deg 

C” in the example UI picture above. 

3. Image Size and Sampling Data information: shows the pixel resolution of the images on display 

(in pixels, width × height), and the information of the Sampler Box which includes the coordinates 

of the Sampler Box, the size of the Sampler Box (in pixels, width × height), and the intensity 

averaged across the Sampler Box. This information can be used for checking saturation at any 

location on the image.  

Note: the maximum possible raw data is “1023”, which means a saturation may occur. 

4. Progress Bar: Displays the progression of the image acquisition and data process. When the 

progress bar is fully filled, a “ding” sound will be played, indicating all the processes are completed. 

5. Exposure Slider: allows user to adjust imager’s exposure time, thus the brightness of the preview 

images. The current exposure time, in milliseconds, is displayed on top of the slider.   

6. Gain Slider: allows user to adjust imager’s gain, thus the brightness of the preview images. The 

current gain, in dB, is displayed on top of the slider. 

7. #Frames to Acquire Slider: allows user to adjust the number of raw images (max 200, min 50) 

to be acquired for one measurement. In principle, a greater number of raw images enhances 

spectral resolution after processing, albeit at the expense of prolonged acquisition time. This 

setting offers users an opportunity to find a balance between spectral precision and acquisition 

speed. The current number of frames to be acquired is displayed on top of the slider. 

8. Acquisition Settings: provides several options for data acquisition operations, as listed below: 

1) Continuous Run (checkbox): When selected (checked), clicking the Acquisition Button will 

carry out multiple measurements continuously according to the settings in Total # of Run box 

and Interval (seconds) box. The number entered in Total # of Run box indicates the total 

number of measurements to be performed. The Continuous Run will stop when this number 

is reached. If the entered number is “0”, the Continuous Run will be nonstop. To stop a 

Continuous Run prematurely, uncheck this checkbox or click the Acquisition Button again. 

The number entered in Interval (seconds) box defines the quiet time (in seconds) in between 

the end of one measurement and the start of next. By default, this option is NOT selected. 

When the continuous run checkbox is selected, a pop-up will also appear asking whether to 

acquire and then process data, or to do the processing and acquisition at the same time. 

Choosing “no” means that the processing will be done immediately for each image. 
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2) External Trigger (checkbox): When selected (checked), the measurements will be started by 

external trigger signals. Clicking the Acquisition Button will let the program get into a state 

of waiting for external trigger signals. The number entered in Target # of Run box indicates 

the total number of measurements to be performed. The App won’t respond to any further 

trigger signal when this number is reached. If the entered number is “0”, the App will accept 

and process an unlimited number of external trigger signals. To quit an External Trigger Run 

anytime, uncheck this checkbox or click the Acquisition Button again. The number shown in 

# of Trigger Processed box indicates the number of trigger signals have been processed. By 

default, this option is NOT selected. When the continuous run checkbox is selected, a pop-up 

will also appear asking whether to acquire and then process data, or to do the processing and 

acquisition at the same time. Choosing “no” means that the processing will be done 

immediately for each image. 

3) Auto Save (checkbox): if selected (checked), clicking the Acquisition Button will perform the 

measurements AND automatically save the results of band images (and raw images if selected 

in the Save tab) and spectra (from the location marked with the Sampler Box in the Analyze 

tab) to the below default folders: 

(For images) C:\BaySpec\GoldenEye\saved_images 

(For spectra) C:\BaySpec\GoldenEye\saved_spectra 

By default, this option is NOT selected. 

Note: if Auto Save is selected, ensure the Sampler Box within the Analyze tab is positioned 

atop the image area of utmost interest. 

4) High Resolution (checkbox): if selected (checked), the raw images will be captured at a higher 

pixel resolution of 1280×1024. By default, this option is NOT selected, and the raw images 

will be captured at a normal pixel resolution of 640×512.  

Note: Enabling high-resolution mode necessitates a PC with 32GB or more of RAM for 

proficient data processing. 

9. Acquisition Button: use this button to start an image acquisition sequence. When this button is 

clicked, the program will start acquiring raw images from the imager according to the Acquisition 

Settings (see details in Item 8 above).  

1) If neither Continuous Run nor External Trigger option is selected, the face text of this button 

shows Take Picture. Clicking the button, the App will acquire the raw images and be 

immediately followed by processing the images and building one Hyperspectral cube.  

2) If the Continuous Run option is selected, the button shows Start Continuous Run. Clicking 

the button, the App will continuously acquire raw images and process them depending on the 

user selection of the process options (See more details in Raw Images Handling Options 

below). During a Continuous Run, the face text of this button changes to Stop Continuous 

Run. Clicking the button will stop the continuous data acquisition. 

Tips: Before starting a Continuous Run measurement, examine the preview image int the 

Image Display Panel and make sure it is focused (detailed and sharp) and no part of the image 

on the display is saturated. If some regions show potential saturation, adjust exposure, gain and 

the lens aperture to eliminate the potential saturation regions. The rule of thumb for avoiding 
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saturation in the entire acquisition process is to bring the highest average intensity measured 

by the sampler box on the preview image below 1000. 

3) If the External Trigger option is selected, the button shows Start External Trigger Run. 

Clicking the button, the App will enter a state of waiting for external trigger. When the App 

detects the rising edge of a trigger signal (See Section 1.3 for specifications), it will acquire 

raw images and process them depending on the user selection of the process options (See more 

details in Raw Images Handling Options below). During an External Trigger Run, the face 

text of this button changes to Quit External Trigger Run. Clicking the button will make the 

App exiting from the state of waiting for external trigger.  

4) Raw Images Handling Options. During the standard single measurement, user clicks the 

Take Picture button, and the App will take raw images and immediately process them into one 

Hyperspectral cube. For Continuous Run and External Trigger measurements, there are raw 

image handling options that allow user to choose to process the raw images immediately or do 

the process later (effectively separating the steps of acquiring and processing the raw images). 

The separation of acquisition and process enables a more rapid acquisition of the data, without 

a need to wait for the processing step to complete, thus avoiding a longer time gap between the 

hyperspectral cubes. 

 

To access the options, initiate by selecting the Continuous Run or External Trigger checkbox. 

Subsequently, a message box will appear, inquiring whether you intend to segregate the 

acquisition and processing stages, as exemplified in the figure below: 
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If No is selected, then the App will run the data acquisition and process normally, i.e. acquiring 

one set of raw images and immediately processing them into one Hyperspectral cube.  

 

If Yes is selected, a dialog box will be opened for Select or create data folder, which allows 

user to decide where to save the raw images acquired in the multiple runs, as shown in the 

figure below.  

 

 
 

User can then create a folder, or select an existing one, and just press Select Folder button to 

dismiss the dialog box. It is important to note that after this step, both the Continuous Run or 

External Trigger, and the Auto Save options will be enabled (the options should remain 

selected), since all raw images acquired during this process must be saved so that they can be 

processed afterward. 

 

At this point the acquisition of raw images can be started by clicking the Acquisition button, as 

described above. 

 

Note: Upon completion of image acquisition, a fleeting flash will be perceptible within the Image 

Display Panel. 

Warning: Shifting to alternate tabs prior to the completion of image acquisition might lead to 

program instability. 
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10. Process Button: use this button to start processing the pre-saved raw images and build 

Hyperspectral cubes. When this button is clicked, the program will start processing pre-saved raw 

images. This can be done after continuous or external trigger acquisition, or at any other time user 

wants to process any raw images. 

 

After raw image acquisition is completed with Continuous Run or External Trigger modes, 

clicking this button will show a Select first file dialog box, through which one can navigate and 

find the data (see the figure below). Select any of the raw data files (marked _raw in the file name) 

and then click Open button to dismiss the dialog box and start the process. 
 

 
 

Note that any one of raw data files in the folder can be selected because all the raw data files in 

the folder will be automatically processed. There is a safety check on whether the folder already 

contains processed data. If user happens to select a folder containing processed data, a pop-up 

message box (as shown below) is shown to allow a choice of whether to overwrite the files.  
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If user selects not to overwrite by No button, nothing will happen, so that one may press Process 

button again and select a different folder with data that hasn’t been processed yet. If the user does 

click Yes button to choose to overwrite the data (for example if more data files have been added 

to the folder), all the _raw image files in the folder, regardless of whether processed or not, will 

be processed. This may be the easiest way to ensure everything in the folder is analyzed. 

After the data is processed, the last processed data cube will be shown in the View and Analyze 

tabs. 
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2.3 View tab 

The UI associated with View tab allows user to review the raw images that were acquired in Acquire 

operation. 

 

There are a few of components on the Control and Information Panel. Here are their description and 

function: 

1. Sampler Box: for measuring average intensity about the enclosed area on raw image. Within the 

Image Display Panel, the sampler box can be moved by either single-clicking left or right mouse 

button, or dragging with holding the right mouse button down, to anywhere on the raw image (will 

center the sampler box at the point where mouse button is released). The sampler box can also be 

resized by either rolling the mouse scroll wheel (will keep the center of the sampler box unchanged) 

or dragging with holding the left mouse button down (will create a new sampler box). 

2. Image Size and Sampling Data information: shows the pixel resolution of the images on display 

(in pixels, width × height), and the information of the Sampler Box which includes the coordinates 

of the Sampler Box, the size of the Sampler Box (in pixels, width × height), and the intensity 

averaged across the Sampler Box. 

3. Frame selection slider: for user to select which frame to be displayed on the Image Display Panel. 

There is a series of frames or images being taken during Acquire operation. By scrolling the slider, 

you can review any of those raw images. 

4. Brightness and Contrast sliders: for user to adjust the appearance or brightness/contrast of the 

image on display.   

6 

5 

4 

3 

1 

2 

http://www.bayspec.com/


      GoldenEye HSI User Manual 

Document No. 94-101535 | www.bayspec.com  Page 18                     February 2024 

 

5. Waveform Plot: this is the raw data from the series of image frames. The raw data is averaged 

across the sampler box. The data should look somewhat like the below figure as you move the 

sampler box around: 

 

 

If it looks like the two figures below (note the “clipping” at the tops of the images), that means 

that the selected region of the image has saturated in some of the frames. The image series is more 

saturated in the left figure than the right, but both indicate saturation. 

 

      
 

6. Reference Waveform Plot: this is the interferogram of the internal reference source.  

 

 

If it does not look like this (i.e., significantly fewer oscillations, distorted, etc.) then something is 

wrong—screenshot and send us and we will advise.   
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2.4 Analyze tab 

The UI associated with Analyze tab allows user to review the Hyperspectral data, i.e. the band images 

inside the Hyperspectral cube, and view and save the spectrum of a selected region. 

 

 

There are a few of components on the Control and Information Panel. Here are their description and 

function: 

1. Sampler Box: for measuring average intensity about the enclosed area on band image. Within the 

Image Display Panel, the Sampler Box can be moved by either single-clicking left or right mouse 

button, or dragging with holding the right mouse button down, to anywhere on the band image 

(will center the Sampler Box at the point where mouse button is released). The Sampler Box can 

also be resized by either rolling the mouse scroll wheel (will keep the center of the Sampler Box 

unchanged) or dragging with holding the left mouse button down (will create a new Sampler Box). 

2. Image Size and Sampling Data information: shows the pixel resolution of the images on display 

(in pixels, width × height), and the information of the Sampler Box which includes the coordinates 

of the Sampler Box, the size of the Sampler Box (in pixels, width × height), and the intensity 

averaged across the Sampler Box.  

3. Wavelength/Band selection slider: allow user to select which wavelength/band image to be 

displayed on the Image Display Panel. The selected wavelength/band indicated below the slider, 

and in the spectrum plot as well (as a green line). 

4. Brightness slider: allows user to adjust the brightness of the image on display. 
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5. Save Spectrum button: allows user to save the current spectrum to a “.csv” file. Clicking this 

button will bring up the Save Spectrum dialog for user to choose a folder and file name for the 

saved file. 

 
Note that, if the Auto Save option is selected in the Acquire tab, the Save Spectrum dialog will 

not be shown, and the spectrum file will be saved into the default folder for spectra (see Page 12). 

6. Spectrum Plot: displays the spectrum curve of the region selected by the Sampler Box. The 

Sampler Box can be moved around to show the spectrum of the sampled area.  
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2.5 Save tab 

The Save tab is for saving the Hyperspectral data to hard drive, and for loading the pre-saved 

Hyperspectral data into the App.  

 

There are a few of components on the UI associated with Save tab. Here are their description and function: 

1. Save spectral image (button): for starting the saving process. 

2. Saving process information: displays the information of saving process. 

3. Save Raw Images (checkbox): allows user to select including the raw images in saving process 

4. File Base Name (edit box): allows user to provide a file base name for saving purpose. 

5. Load spectral image (button): for starting the loading process. 

6. Loading process information: displays the information of loading process. 

7. Folder/File List: displays a list of subfolders and files in the current folder.  
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2.5.1 Save Data 

To save the currently acquired (a.k.a. Raw) and processed (a.k.a. Hyperspectral band) images, provide a 

file base name (default is spectral_image) in the edit box labeled File Base Name, then click Save spectral 

image button to start the saving process. Saving the Raw images is optional and can be selected by Save 

Raw Images checkbox. 

 

By default, all the images are saved in a subfolder under the default folder of 

C:\BaySpec\GoldenEye\saved_images, which is named in below format: 

\(user-defined file base name)_timestamp_gain_exposure_device-temperature.  

Note that, the name for the subfolder is automatically generated, which should not be altered, or the saved 

data will not be properly reloaded and displayed in the App in a later time. 

The Save spectral image function will save the following images and any associated data in the subfolder 

if they are available: 

1. (Optional) Raw image files labeled “(user-defined file base name)_raw.bin” 

2. Processed image files labeled “(user-defined file base name)_processed_image.bin” 

3. ENVI header file for compatibility with commercial HSI imaging software, labeled “(user-

defined file base name)_processed_image.hdr” 

4. Any associated data, if available, typically in “.csv” format 

http://www.bayspec.com/


      GoldenEye HSI User Manual 

Document No. 94-101535 | www.bayspec.com  Page 23                     February 2024 

 

Note: If Continuous Run and Auto Save options are selected in Acquire tab, an index number will be 

included in the name of the image files, indicating the order of the files saved during the continuous 

measurements. 

 

The data format for the saved image files is 16-bit unsigned integer, little-endian, for each data point. For 

raw image files, the Number of frames saved in sequence is determined by the “#Frames to Acquire” set 

in Acquire tab (see Page 11). For processed image files, the Number of bands saved in sequence is 141 

(default) or the number of user-defined wavelengths in “wavelengths.csv” (see Note on Page 7). Therefore, 

the total numbers of 16-bit data contained in each of the saved image files (.bin) are: 

Raw images (frames x columns x rows):  

1. For normal pixel resolution: (Number of frames) x 640 x 512  

2. For high pixel resolution: (Number of frames) x 1280 x 1024 

Processed images (bands x columns x rows): 

1. For normal pixel resolution: (Number of bands) x 640 x 512  

2. For high pixel resolution: (Number of bands) x 1280 x 1024 

Note: Upon saving the processed images (band images), the corresponding wavelengths for each 

band image are simultaneously preserved within a data file labeled “(user-defined file base 

name)_wavelengths.csv” in the same folder.   
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2.5.2 Load Data 

To load the saved raw and processed images, open or drop-down the subfolder where contains the image 

files you want to load, select any “.bin” file from the file list panel on the right, then click “Load spectral 

image” button to start the loading process.  

 
 

All files in the subfolder will be loaded into the App. After the loading process completed, the Raw 

images (if existing in the folder) are displayed in View tab, and the Hyperspectral band images are 

displayed in Analyze tab.  
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2.6 View Saved Raw Images and Hyperspectral Band Images 

While the saved Raw images and Hyperspectral band images can be viewed by loading into this App, they 

can also be viewed or further processed by using third party software, such as FIJI, ImageJ, Scyven, ENVI, 

and any ENVI compatible software.  

2.6.1 View Images with FIJI/ImageJ 

To load an image into FIJI or ImageJ, do the following: 

• Go to File→Import→Raw… 

• Choose the saved ‘.bin’ file from C:\BaySpec\GoldenEye\saved_images 

• Use the following settings: 

 

    
(For normal pixel resolution)    (For high pixel resolution) 

 

Note: Number of images → for the band images, use 141 or the number of user-defined 

wavelengths in “wavelengths.csv”; for the raw images, use the “#Frames to Acquire” set in 

Acquire tab. 

 

• To label the image wavelength (in FIJI): Go to Image→Stacks→Series Labeler, and apply the 

following settings: 
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2.6.2 View Images with Scyven/ENVI 

Hyperspectral image files can be loaded into Scyven or ENVI by selecting the “.hdr” file directly in 

the saved data folder. If there is no “.hdr” file in the data folder, copy the supplied  

“file_name_here.hdr” to the same folder as the image file and change everything in the filename but 

the “.hdr” to match the “.bin” filename without extension. For example, if you want to open “foo.bin”, 

rename “file_name_here.hdr” to “foo.hdr” and place the two files in the same folder.  Then, open 

“foo.hdr” with Scyven or ENVI. 
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2.7 Quit the Program 

There are three ways to quit the program: 

1. Press the “Esc” key on the keyboard.  

 
 

2. Close the window as normal via the top right corner of the window.  

 
 

3. Click the icon on the top left corner of the window, or right click anywhere on the title bar, to 

bring up the context menu and select “Close”. 
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